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Minimum System Requirements
Hardware






IBM Compatible PC (Refer to Mac support policy)
900 MHz processor (2 GHz recommended)
1 GB RAM (2 GB recommended)
50 MB hard disk storage
1024 x 768 screen resolution with at least 16-bit color

Software
 HotDocs® 11, 10, 2009, 2008 Standard/User Edition or Professional/Developer/Developer Lite Edition – Desktop versions
(HotDocs® Player and Cloud versions not compatible)
 Microsoft® Windows® 10, 8, 7, Vista®
 Google™ Chrome™ or Mozilla® Firefox® Browser (recommended to be set as browser default)
 Microsoft® Office® Word 2016, 2013, 2010, 2007, 2003 (WordPerfect® not compatible)

Member Passwords
Advanced Planning Solutions, LLC issues one set of password to members so that members can access the member web
site(s). The passwords are to be used by members and their employees. You will need your member username and
password to log into the FundingPro™, SettlementPro™, and PlanningPro™ member websites. Members may change their
password in the members’ account “profile” (“My Account”). To retrieve lost passwords, follow the instructions on the
password login page to have a password reset email sent to you. The password reset message is sent to the email address
of record (usually the email address the member provides to us at subscription). To maintain the security of our website
and their software subscription, members should change their passwords whenever they have a change in personnel.

Mac Support Policy
Although some users are operating HotDocs® and our software systems with success on a Mac using a virtual Windows
environment, HotDocs® is not certified for use with the FundingPro™, SettlementPro™, or PlanningPro™ software systems.
HotDocs® is not developed or tested in the Mac operating system. Consistent with HotDocs®'s official policy, we do not
support the operation of our software systems on a Mac computer and cannot assist with support questions related to the
Mac configuration. Support for the Mac configuration is the responsibility of the user.

About the FundingPro™, SettlementPro™, and PlanningPro™ Software Systems (also known as the ProSuite™)
The ProSuite Systems are HotDocs-based template modules for estate planners. They are integrated with each other to
share data and leverage efficiencies. The FundingPro System funds trusts at design and manages trust funding for estate
plan maintenance. The SettlementPro System facilitates disability and post-mortem trust administration. The PlanningPro
Software System is a trust drafting assembly system supplied exclusively to members of the National Network of Estate
Planning Attorneys. Training and usage resources are provided on the “Training” pages of the product member web sites.

Software Definitions
HotDocs® – Document assembly software by HotDocs Corporation and the software engine for the ProSuite systems.
ProSuite™ – FundingPro, SettlementPro, and PlanningPro integrated software systems for estate planners.
Answer Files – Data files created in HotDocs containing client information entered by the user.
Library Files – Functionality for working with software templates; displays software operation menu in HotDocs.
Templates or Template Files – Documents, forms, and reports created in HotDocs and for the purpose of drafting, funding,
settling living trusts.
© 2020 Advanced Planning Solutions, LLC
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Installation and Configuration – Standard Workstation Installation (C Drive)
1.

Install HotDocs® Software

The FundingPro™, SettlementPro™, and PlanningPro™ software systems (also known as the ProSuite™) require a desktop
copy of the HotDocs® document assembly software. HotDocs User version is sufficient to operate the FundingPro,
SettlementPro, and PlanningPro software systems. Users who plan to develop their own templates or require advanced
programming capabilities will need a copy of HotDocs Developer or Developer LE. HotDocs Developer and Developer LE are
fully compatible with the ProSuite systems. (Note that HotDocs Player, Server, or Cloud products are not compatible.)
HotDocs is installed from the “Downloads” page of the HotDocs website (www.hotdocs.com) or from an installation link
emailed by HotDocs to the user at time of purchase. Use the license key provided by HotDocs when installing the software.
Be sure to close all programs, especially those using Microsoft Word and any existing versions of HotDocs you may have
open.
Install HotDocs
Using the HotDocs setup.exe file and your license key, perform a “Typical” installation to establish a standard C drive
installation. For help installing HotDocs, refer to HotDocs documentation or contact HotDocs support at (800) 8288328. We recommend you back up and save your HotDocs installation file and your license key in case you need to
reinstall HotDocs in the future. Contact HotDocs to obtain lost license keys.
2.

Install the FundingPro, SettlementPro, PlanningPro (ProSuite) Software Systems

Once HotDocs is installed, go to the Advanced Planning Solutions, LLC website (www.advancedplanningllc.com) to log in to
install the FundingPro™, SettlementPro™, and PlanningPro™ Software Systems. The installation files are located on the
“Download” page of each product site. Microsoft® Browsers are not compatible. Google™ Chrome™ or Mozilla® Firefox®.
Install FundingPro™ SettlementPro™ and PlanningPro™

3.

1.

Using your member passwords, log in to the FundingPro, SettlementPro or PlanningPro product website from the
advancedplannningllc.com web site using the “Login” links.

2.

Go to the “Download” page of the product website.

3.

Use the “full installation file” link to install the software. (For PlanningPro install both the installation file and
current monthly update.) Click the link and follow the browser prompts to install the file. “Opening” the file is the
preferred approach in most browsers.

4.

Select the local drive locations for the templates and the library files. Then install the files when prompted. Once
installed, the ProSuite™ product will display in the HotDocs software.

5.

Install additional ProSuite systems by going to the product websites and installing them from the “Download”
page. Use the “My Account” link in the upper right corner of the product website to access other product websites
(product links are provided on My Account “Main Page”).

Configure the HotDocs File Management Setting

The HotDocs File Management setting determines how the HotDocs answer files (see software definitions) are displayed
and viewed within the HotDocs software. We recommend changing the File Management setting from the default setting as
described below.
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Change the HotDocs File Management Setting

4.

1.

Launch HotDocs from the Start button or from an application shortcut.

2.

Select the “Tools” menu.

3.

Click “Options”.

4.

In the HotDocs Options window, select the “File Management” Folder on the left.

5.

Change “Manage answer files using” to “Windows Explorer”.

6.

Click OK.

Configure the HotDocs Navigation Setting

The HotDocs Navigation Setting determines how the software interview screens are presented to the user during
navigation. We recommend you change this to our recommended setting when operating any of the ProSuite systems.
Once you change the Navigation setting, the setting remains changed until you change it back or reinstall HotDocs. If you
use additional HotDocs template systems, you may need to change the setting back to the default if your template
interview does not flow as expected.
Change the HotDocs Navigation Setting

5.

1.

Double-click on “Data Entry” in either FundingPro or SettlementPro.

2.

At the answer file prompt, click OK on a new answer file (or open an existing one).

3.

Click on the “Navigate” menu and locate the “Next Dialog Follows Outline” menu item.

4.

If the item is checked, click or select it to “uncheck” it.

5.

If you need to re-check it again, simply select it to do so.

6.

Exit HotDocs if desired.

Updating the FundingPro, SettlementPro, and PlanningPro Software Systems

The FundingPro, SettlementPro, and PlanningPro Software Systems are updated on a monthly basis to keep them current
st
and to deliver bug fixes. The software prompts you to update when needed. Updates are posted on the 1 of every month
th
th
and need to be installed by the 15 to continue usage. If the software is not updated by the 15 of the month, the software
will expire and require the update. This approach keeps the ProSuite software current for all users.
Update Options: FundingPro and SettlementPro have two update options: full update or monthly update. The full update
includes programming and template updates. The monthly update contains programming updates only. The monthly
update option is designed for users who customize the templates and do not want those customizations overwritten in the
update process.
The PlanningPro trust drafting system has a separate customization process. When the prescribed customization technique
is followed as detailed in the PlanningPro customization training video on the PlanningPro “Training” web page, users many
simply update their software monthly and not risk overwriting their custom templates.
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Update the FundingPro or SettlementPro Software System
1.

Launch the FundingPro or SettlementPro Software System in HotDocs.

2.

Determine the appropriate update you wish to use (“full” or “monthly” – see update options above).

3.

Double-click on the update link provided in the software library (or go to the software “Download” web page).

4.

Log in with your member passwords if prompted.

5.

Click to Open the update file (or double-click on it when it is downloaded).

6.

At the “Install Templates” prompt, click “Overwrite All” to install the update.

7.

Click OK when finished.

Update the PlanningPro Software System
1.

Launch the PlanningPro Software System in HotDocs.

2.

Double-click on the “Update PlanningPro” link in the software library.

3.

Log in with your member passwords if prompted.

4.

Click to Open the update file (or double-click on it when it is downloaded).

5.

At the “Install Templates” prompt, click “Overwrite All” to install the update.

6.

Click OK when finished.
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Installation and Configuration – Network Drive Installation
Networked installations allow multiple users to share the ProSuite software, client Answer Files, and templates that users
customize themselves for their particular legal requirements. Included in your software subscription is a site license for up
to 5 users of the ProSuite software. HotDocs licensing requires one (1) desktop copy of HotDocs per workstation.
Networked installations should be performed by a qualified network administrator. Because network environments are
unique to various subscribers, users are responsible for supporting and configuring their own computer networks. The
following instructions are useful guidelines when configuring the ProSuite software systems to a network installation.

Install HotDocs® Software
The FundingPro™, SettlementPro™, and PlanningPro™ software systems (also known as the ProSuite™) require a desktop
copy of the HotDocs® document assembly software installed on each workstation. HotDocs User version is sufficient to
operate the FundingPro, SettlementPro, and PlanningPro software systems. Users who plan to develop their own templates
or require advanced programming capabilities will need a copy of HotDocs Developer or Developer LE. HotDocs Developer
and Developer LE are fully compatible with the ProSuite systems. (Note that HotDocs Player, Server, or Cloud products are
not compatible.)
HotDocs is installed from the “Downloads” page of the HotDocs website (www.hotdocs.com) or from an installation link
emailed by HotDocs to the user at time of purchase. Use the license key provided by HotDocs when installing the software.
Be sure to close all programs, especially those using Microsoft Word and any existing versions of HotDocs you may have
open.
Install HotDocs
Using the HotDocs setup.exe file and your license key, perform a “Typical” installation to establish a standard C drive
installation that you can change to a “Networked” installation afterward. For help installing HotDocs, refer to HotDocs
documentation or contact HotDocs support at (800) 828-8328. We recommend you back up and save your HotDocs
installation file and your license key code in case you need to reinstall HotDocs in the future. Contact HotDocs to obtain
lost license keys.

Configure HotDocs software for a network installation
Members configure the ProSuite™ software to a network so multiple users can operate the software, particularly important
when users customize templates. Create the folders for a network installation and then connect those folders to HotDocs to
create the network configuration. Important Note: HotDocs does not configure well to Universal Naming Convention (UNC)
drive paths. Use “letter drives” instead of UNC paths when naming your network.
Create folders for a network installation
1.

On the server or network drive, create a new HotDocs root folder (e.g. X:\HotDocs\)

2.

Create 3 new subfolders in the new HotDocs folder for “Answer Files”, “Library Files”, and “Templates”
(e.g. X:\HotDocs\Answer Files\).

3.

Configure permissions so that user profiles can write to or edit the HotDocs folder.

Connect HotDocs to folders for network configuration
1.

Launch HotDocs from the Start menu or application shortcut.
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2.

Select the “Tools” Menu.

3.

Click “Options”.

4.

At the HotDocs Options window, click the “File Locations” folder on the left.

5.

In the “HotDocs Folders” window on the upper right, edit the “Library Files”, “Template Files”, “Template Sets”,
and “Answer Files” to change them to the new network folders. Click Edit and copy the new file path to the field
or browse to it using the button provided. Click OK to confirm. Make sure you change all 4 file path settings
accordingly.

6.

Click OK to close the HotDocs Options window.

Install the FundingPro, SettlementPro, PlanningPro (ProSuite) Software Systems
Once HotDocs is installed and configured to the network, go to the Advanced Planning Solutions, LLC website
(www.advancedplanningllc.com) to log in to install the FundingPro™, SettlementPro™, and PlanningPro™ Software Systems.
The installation files are located on the “Download” page of each product site. Microsoft® Browsers are not compatible.
Google™ Chrome™ or Mozilla® Firefox®.
Install FundingPro™ SettlementPro™ and PlanningPro™
1.

Using your member passwords, log in to the FundingPro, SettlementPro or PlanningPro product website from the
advancedplannningllc.com web site using the “Login” links.

2.

Go to the “Download” page of the product website.

3.

Use the “full installation file” link to install the software. (For PlanningPro install both the installation file and
current monthly update.) Click the link and follow the browser prompts to install the file. “Opening” the file is the
preferred approach in most browsers.

4. Select the network drive locations for the templates and the library files at the installation prompt. Click OK to
begin the install. Once installed, the ProSuite product will display in the HotDocs software.

5.

Install additional ProSuite systems by going to the product websites and installing them from the “Download”
page(s). Use the “My Account” link in the upper right corner of the product website to access other product
websites (product links are provided the “Main Page” of “My Account”).

Connect Workstations to the Network Installation
Once the ProSuite software is installed on the server drive through one workstation, you now need to connect all other
workstations to the installation. This is accomplished by configuring the HotDocs file location paths on each machine as
described above (“Connect HotDocs to folders for network configuration”) and then add each ProSuite™ software reference
path to configure HotDocs to the existing network installation.
1.

Launch HotDocs from the Start menu or application shortcut.

2.

Select the “Tools” Menu.

3.

Click “Options”.

© 2020 Advanced Planning Solutions, LLC
Rev. 08/2020

9
4.

At the HotDocs Options window, click the “File Locations” folder on the left.

5.

In the “HotDocs Folders” window on the upper right, edit the “Library Files”, “Template Files”, “Template Sets”,
and “Answer Files” to change them to the new network folders. Click the Edit and copy the new file paths to the
fields or browse to them using the button provided.

6.

In the “Reference Path” window below, Click Add to insert the corresponding reference paths for each program
being configured.

7.

In the “Add/Edit Reference Paths” window, type the relevant ProSuite software keyword in the reference path
field. Reference paths are case-sensitive and must be typed exactly as they appear on the original workstation
installation (see example reference paths below). Then add the “Templates” file path in the path field by pasting
it in or browsing to the template root folder. Click OK.
–FundingPro reference path: “PUBFundingPro” followed by the version number (e.g. PUBFundingPro2016)
–SettlementPro reference path: “PUBSettlementPro” followed by the version number (PUBSettlementPro2016)
–PlanningPro reference path: “PUBPlanningPro” followed by the version number (PUBPlanningPro2016)
IMPORTANT NOTE: When adding the ProSuite software reference path, please make sure you do NOT add the
“PUB” folder location to the end of the file path. HotDocs automatically adds that folder from the “Keyword”
field containing the “PUB” folder reference. Reference path example: X:\HotDocs\Templates\.

Click OK to close the HotDocs Options window or configure the File Management setting as described below in item
5 below prior to closing the HotDocs Options window.

Configure the HotDocs File Management Setting
The HotDocs File Management setting determines how the HotDocs answer files (see Software Definitions) are displayed
and viewed by the HotDocs software. We recommend changing the File Management setting from the default setting as
described below.
Change the HotDocs File Management Setting
1.

Launch HotDocs from the Start button or from an application shortcut.

2.

Select the “Tools” menu.

3.

Click “Options”.

4.

In the HotDocs Options window, select the “File Management” Folder on the left.

5.

Change “Manage answer files using” to “Windows Explorer”. Click OK.
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Configure the HotDocs Navigation Setting
The HotDocs Navigation Setting determines how the software interview screens are presented to the user during
navigation. We recommend you change this to our preferred setting when operating any of the ProSuite systems. Once you
change the Navigation setting, the setting remains changed until you change it back or reinstall HotDocs. If you use
additional HotDocs template systems, you may need to change the setting back to the default if your template interview
does not flow as expected.
Change the HotDocs Navigation Setting
1.

Double-click on “Data Entry” in either FundingPro or SettlementPro.

2.

At the answer file prompt, click OK on a new answer file (or open an existing one).

3.

Click on the “Navigate” menu and locate the “Next Dialog Follows Outline” menu item.

4.

If the item is checked, click or select it to “uncheck” it.

5.

If you need to re-check it again, simply select it to do so.

6.

Exit HotDocs if desired.

Updating the FundingPro, SettlementPro, and PlanningPro Software Systems
The FundingPro, SettlementPro, and PlanningPro Software Systems are updated on a monthly basis to keep them current
st
and to deliver bug fixes. The software prompts you to update when needed. Updates are posted on the 1 of every month
th
th
and need to be installed by the 15 to continue usage. If the software is not updated by the 15 of the month, the software
will expire and require the update. This approach keeps the ProSuite software current for all users.
Update Options: FundingPro and SettlementPro have two update options: full update or monthly update. The full update
includes programming and template updates. The monthly update contains programming updates only. The monthly
update option is designed for users who customize the templates and do not want those customizations overwritten in the
update process. If you are not customizing FundingPro or SettlementPro, you may install the full update.
The PlanningPro trust drafting system has a separate customization process. When the prescribed customization technique
is followed as detailed in the PlanningPro customization training video on the PlanningPro “Training” web page, users many
simply update their software monthly and not risk overwriting their custom templates. Microsoft® Browsers are not
compatible. Google™ Chrome™ or Mozilla® Firefox®.
Update the FundingPro or SettlementPro Software System
1.

Launch the FundingPro or SettlementPro Software System in HotDocs.

2.

Determine the appropriate update you wish to use (“full” or “monthly” – see update options above).

3.

Double-click on the update link provided in the software library (or go to the software “Download” web page).

4.

Log in with your member passwords if prompted.

5.

Click to Open the update file (or double-click on it after it is downloaded).
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6.

At the “Install Templates” prompt, click “Overwrite All” to install the update.

7.

Click OK when finished.

Update the PlanningPro Software System
1.

Launch the PlanningPro Software System in HotDocs

2.

Double-click on the “Update PlanningPro” link in the software library

3.

Log in with your member passwords if prompted.

4.

Click to Open the update file (or double-click on it when it is downloaded).

5.

At the “Install Templates” prompt, click “Overwrite All” to install the update.

6.

Click OK when finished.
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Moving Standard Installation (C Drive) to a Network Drive
Networked installations allow multiple users to share the ProSuite software, client Answer Files, and templates that users
customize themselves for their particular legal requirements. Included in your software subscription is a site license for up
to 5 users of the ProSuite software. HotDocs licensing requires one (1) desktop copy of HotDocs per workstation.
Networked installations should be performed by a qualified network administrator. Because network environments are
unique to various subscribers, users are responsible for supporting and configuring their own computer networks. The
following instructions are useful guidelines when configuring the ProSuite software systems to a network installation.
If you already have a C drive installation of FundingPro, SettlementPro, or PlanningPro, you may wish to move it to a
network drive or server location to share the software among multiple users. First: You will need to establish a software
network location. Second: You will need to identify the location of your existing software and move all software elements to
the new network location or server drive. Last: You will need to connect (or reconfigure) the local HotDocs software on each
machine to the server location to operate the software from the network.
Establish a network location
1.

On the server or network drive, create a new HotDocs root folder (e.g. X:\HotDocs\)
Important Note: HotDocs does not configure well to Universal Naming Convention (UNC) drive paths. Use “letter
drives” instead of UNC paths when naming your network.

2.

Create 3 new subfolders in the new HotDocs folder for “Answer Files”, “Library Files”, and “Templates”
(e.g. X:\HotDocs\Answer Files\).

3.

Configure permissions so that user profiles can write to or edit the HotDocs folder.

Move software to network location
1.

Locate (or search for) the FundingPro, SettlementPro, and PlanningPro software on the C drive. Standard C drive
installations are typically in the HotDocs folders located in “Public Documents” or “My Documents”.

2.

Identify that you have located both the .hdl HotDocs library file (e.g. “PUBFundingPro****.hdl”) and template
folder of the same name (e.g. “PUBFundingPro****”).

3.

Copy both the .hdl library file and the corresponding template folder to the new server folders created for
HotDocs “Library Files” and “Templates” in the steps above. Copy all library files and template folders for each
ProSuite product you wish to move. You will have one library file (.hdl) and one template folder for each software
module.

4.

Locate the HotDocs answer files and picklists that may have been created already in the ProSuite software
systems. If you are not certain where the files are, search the computer for files with the following HotDocs file
extensions:
Answer Files (Binary) – *.ans
Answer Files (XML) – *.anx
Picklist Files – *.hpl

5.

Once you have located all the HotDocs Answer Files and Picklist Files, copy them to the new server folder created
for HotDocs “Answer Files” in the steps above.

Connect workstations to the network installation
1.

From the various workstations, launch HotDocs from the Start menu or application shortcut.
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2.

Select the “Tools” Menu.

3.

Click “Options”.

4.

At the HotDocs Options window, click the “File Locations” folder on the left.

5.

In the “HotDocs Folders” window on the upper right, edit the “Library Files”, “Template Files”, “Template Sets”,
and “Answer Files” to change them to the new network folders. Click the Edit and copy the new file paths to the
fields or browse to them using the button provided.

6.

In the “Reference Path” window below, Click Add to insert the corresponding reference paths for each program
being configured.

7.

In the “Add/Edit Reference Paths” window, type the relevant ProSuite software keyword in the reference path
field. Reference paths are case-sensitive and must be typed exactly as they appear on the original workstation
installation (see example reference paths below). Then add the “Templates” file path in the path field by pasting it
in or browsing to the template root folder. Click OK.
–FundingPro reference path: “PUBFundingPro” followed by the version number (e.g. PUBFundingPro2016)
–SettlementPro reference path: “PUBSettlementPro” followed by the version number (PUBSettlementPro2016)
–PlanningPro reference path: “PUBPlanningPro” followed by the version number (PUBPlanningPro2016)
Click OK to close the HotDocs Options window.
IMPORTANT NOTE: When adding the ProSuite software reference path, please make sure you do NOT add the
“PUB” folder location to the end of the file path. HotDocs automatically adds that folder from the “Keyword” field
containing the “PUB” folder reference. If there is a working computer with the same networking configuration, you
can refer to that machine’s reference paths. Reference path example: X:\HotDocs\Templates\.

8.

To operate FundingPro, SettlementPro, or PlanningPro from the individual workstations, click the “File” menu in
HotDocs and select “Open Library”. Browse to the “Library Files” folder if necessary and select the HotDocs library
files (e.g. “PUBFundingPro****.hdl) to open the software systems and begin using them.

9.

Be sure to configure the File Management setting and the Navigation settings as described below for optimal
software performance.

Configure the HotDocs File Management Setting
The HotDocs File Management setting determines how the HotDocs answer files (see Software Definitions) are displayed
and viewed by the HotDocs software. When you are networking the software, it is particularly important so that all users
can view and edit shared client Answer Files. We recommend changing the File Management setting from the default
setting as described below.
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Change the HotDocs File Management Setting
1.

Launch HotDocs from the Start button or from an application shortcut.

2.

Select the “Tools” menu.

3.

Click “Options”.

4.

In the HotDocs Options window, select the “File Management” Folder on the left.

5.

Change “Manage answer files using” to “Windows Explorer”.

6.

Click OK.

Configure the HotDocs Navigation Setting
The HotDocs Navigation Setting determines how the software interview screens are presented to the user during
navigation. We recommend you change this to our preferred setting when operating any of the ProSuite systems. Once you
change the Navigation setting, the setting remains changed until you change it back or reinstall HotDocs. If you use
additional HotDocs template systems, you may need to change the setting back to the default if your template interview
does not flow as expected.
Change the HotDocs Navigation Setting
1.

Double-click on “Data Entry” in either FundingPro or SettlementPro.

2.

At the answer file prompt, click OK on a new answer file (or open an existing one).

3.

Click on the “Navigate” menu and locate the “Next Dialog Follows Outline” menu item.

4.

If the item is checked, click or select it to “uncheck” it.

5.

If you need to re-check it again, simply select it to do so.

6.

Exit HotDocs if desired.
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Adding a Computer to Your Current ProSuite™ Configuration
ProSuite software licensing allows usage for up to 5 workstations. To add a computer to your current configuration,
proceed in the following way:
Adding a Computer
1.

Obtain a desktop license for HotDocs software by calling HotDocs sales at (801) 615-2201. HotDocs licensing
requires one copy of HotDocs per computer workstation.

2.

Install HotDocs software on the workstation.

3.

Configure the ProSuite by either installing a stand alone copy from the ProSuite member “Download” webpage or
by configuring the HotDocs file locations and reference paths to connect the workstation to the existing network
installation.
To configure HotDocs to an existing network installation, follow the instructions for “Connecting Workstations to a
Network Installation” described on pages 8-9 in this installation guide. You can refer to a working computer’s
configuration as a model for the new machine.
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ProSuite™ Software Systems Sales and Support

Advanced Planning Solutions, LLC
5700 Lombardo Center Drive, Suite 290
Seven Hills, Ohio 44131
www.advancedplanningllc.com
Sales and Support (800) 300-0431
sales@advancedplanningllc.com
support@advancedplanningllc.com

HotDocs® Software Sales and Support
Scott Myers, HotDocs Sales
(858) 736-3729
smyers@abacusnext.com
HotDocs Support
(800) 828-8328
hdsupport@abacusnext.com
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